
 

 

 

Manuale per  

l’assemblaggio, il test e il dressing 

dei Minicrate  

 
Bologna Assembly Site 

2005-06-27 

                                               R.Travaglini et al. 

 

 



 
1. PROCEDURA DI ASSEMBLAGGIO.................................................................... 7 

1.1. PREPARAZIONE PRELIMINARE .............................................................................. 7 
1.2. PREPARAZIONE DISSIPATORI DI CALORE PER LE TRB........................................... 7 
1.3. PREPARAZIONE PRELIMINARE DELLE TRB........................................................... 8 
1.4. INSERIMENTO TRB .............................................................................................. 8 
1.5. ASSEMBLAGGIO CCB .......................................................................................... 9 
1.6. INSERIMENTO SB ............................................................................................... 12 
1.7. MONTAGGIO COPERCHI PER LA DISSIPAZIONE .................................................... 13 
1.8. CABLATURA CAVI TRIGGER TRA TRB E SB....................................................... 15 
1.9. CABLATURA CAVI DALLA CCB.......................................................................... 17 
1.10. INSERIMENTO LINK BOARD ........................................................................... 18 
1.11. CONNESSIONE DELL’ALIMENTAZIONE............................................................ 20 
1.12. PRIMA ACCENSIONE E PROGRAMMAZIONE PRELIMINARE DEGLI FPGA .......... 20 
1.13. PROGRAMMAZIONE FLASH .......................................................................... 21 
1.14. TEST DEL BOUNDARY SCAN........................................................................... 24 
1.15. SPEGNIMENTO................................................................................................ 24 
1.16. CHIUSURA DEI COPERCHI ............................................................................... 24 
1.17. NOTE GENERICHE DI VARIO INTERESSE SUL MINICRATE ................................ 25 

2. ISTRUZIONI PER IL TEST PRE-DRESSING .................................................. 29 

2.1. ISTRUZIONI PRELIMINARI ................................................................................... 29 
2.2. ACCENSIONE DAQ ............................................................................................ 29 
2.3. PRE-ACCENSIONE............................................................................................... 30 
2.4. TEST – PROCEDURA SEQUENZIALE ..................................................................... 30 
2.5. CONFIGURAZIONE DISPOSITIVI .......................................................................... 31 
2.6. IMPOSTAZIONE DEL TIMING SULLE TRB ............................................................ 31 
2.7. ELENCO TEST DA EFFETTUARE .......................................................................... 32 

2.7.1. Check TDC status ..................................................................................... 32 
2.7.2. Calibrazione della Pattern Unit................................................................ 32 
2.7.3. Test TDC crosstalk.................................................................................... 33 
2.7.4. Test TRB switch......................................................................................... 33 
2.7.5. Test Led_RPC: .......................................................................................... 34 
2.7.6. Test CPU Clock phase .............................................................................. 34 
2.7.7. Test Serializers.......................................................................................... 35 
2.7.8. Test TRB emulator .................................................................................... 35 
2.7.9. Test Snap e Software Reset ....................................................................... 36 

2.8. SPEGNIMENTO IN PREPARAZIONE DEL DRESSING................................................ 36 

3. CABLAGGIO DEL MINICRATE AL FRONTEND.......................................... 42 

3.1. ORIENTAMENTO................................................................................................. 42 
3.2. POSIZIONAMENTO .............................................................................................. 42 
3.3. CONNESSIONE DEI CAVI AL MC ......................................................................... 42 
3.4. CONNESSIONE DEL MC PER IL FULL TEST ...................................................... 43 
3.5. CONNESSIONE CAVI TEST PULSE ALLA CCB E ALLA TESTATA............................ 43 

 2



3.6. CONNESSIONI CONCLUSIVE .......................... ERROR! BOOKMARK NOT DEFINED. 

4. ISTRUZIONI PER IL TEST POST-DRESSING................................................ 45 
4.1. PREPARAZIONE PRELIMINARE ............................................................................ 45 
4.2. PRE-ACCENSIONE............................................................................................... 45 
4.3. TEST – PROCEDURA SEQUENZIALE ..................................................................... 45 
4.4. CONFIGURAZIONE DISPOSITIVI .......................................................................... 46 
4.5. IMPOSTAZIONE DEL TIMING SULLE TRB ............................................................ 47 
4.6. ELENCO TEST DA EFFETTUARE .......................................................................... 47 

4.6.1. Test corretta cablatura dei cavi segnale................................................... 47 
4.6.2. Test crosstalk ............................................................................................ 48 
4.6.3. Test TRB TP .............................................................................................. 48 
4.6.4. Test Bti Skew............................................................................................. 48 

5. PREPARAZIONE PER LA SPEDIZIONE ......................................................... 51 

5.1. DISCONNESSIONE DEI CAVI DEL MC DOPO IL FULL TEST................................ 51 
5.2. IMPACCHETTAMENTO DEI CAVI NELLE BUSTE DI ALLUMINIO ............................. 51 
5.3. NOTA PER LE BUSTE IN MB1 E MB2: ............................................................ 52 
5.4. NOTA SULLA PREPARAZIONE DELLE STAFFETTE E DEI FERMACAVI .................... 53 

6. APPENDICE: REVISIONE DELLE ISTRUZIONI PER L’ASSEMBLAGGIO 
DEI CAVI SEGNALE SUI MINICRATE.................................................................... 65 

 

 3



 
FIGURA 2: INSERIMENTO TRB; SI NOTI L’END TRIGGER BUS (VERDE) E IL TRIGGER BUS 

(ROSSO)........................................................................................................................ 9 
FIGURA 3: CCB CABLES CONNECTIONS ............................................................................. 10 
FIGURA 5: ROUTING CAVO RPC IN USCITA DALLA CCB. ................................................... 11 
FIGURA 6: CABLES ROUTING IN USCITA DALLA SB.  DETTAGLIO SU CAVI RPC E 

ALLINEAMENTO. ........................................................................................................ 12 
FIGURA 7: POSIZIONAMENTO SB ....................................................................................... 13 
FIGURA 8: ADERIMENTO DELLA GOMMA TERMOCONDUTTIVA........................................... 13 
FIGURA 9: GOMMA TERMOCONDUTTIVA SUI REGOLATORI DI TENSIONE DELLA TRB......... 14 
FIGURA 10: VITI PER IL FISSAGGIO DEI COPERCHI DI DISSIPAZIONE DELLE TRB. ............... 15 
FIGURA 11: CAVI TRIGGER SUL LATO SB........................................................................... 16 
FIGURA 12: CAVI DI TRIGGER LATO TRB; SI NOTI CHE ESSI SONO PRE-FORMATI IN 

VICINANZA DEI CONNETTORI...................................................................................... 17 
FIGURA 13: CONNESSIONI E DISPOSIZIONE DEI CAVI DI TRIGGER: PARTICOLARE................ 17 
FIGURA 14: CONNETTORE RPC-ALLINEAMENTO E ROUTING DEI CAVI ATTORNO ALLA LINK 

BOARD....................................................................................................................... 18 
FIGURA 16: ROUTING DEL CAVO LINK SOPRA LA SB. ........................................................ 20 
TABELLA 1: CORRENTE ASSORBITA DAI MINICRATE (VALORI DI RIFERIMENTO)................ 22 
FIGURA 17: ESEMPIO DI RIFERIMENTO DI CORRETTO OUTPUT PER IL PROGRAMMA DI BOOT

................................................................................................................................... 22
FIGURA 18: VALORI DI RIFERIMENTO PER L'OUTPUT DEL PROGRAMMA DEL MINICRATE ... 23 
FIGURA 19: MINICRATE LAYOUT....................................................................................... 27 
FIGURA 20: TRB CABLES ROUTING ................................................................................... 28 
FIGURA 21: LINK BOARD CONNECTIONS (BOTH RS485 CONNECTORS ARE EQUIVALENT) . 29
TABELLA 2: SEGNO DELLO SHIFT DEI SUPERLAYER IN FUNZIONE DEL TIPO DI MINICRATE 

(PER GLI MB4 RIFERIRSI AL VALORE DELLO SHIFT INDICATO SULL’ETICHETTA, SUL 
FILE MBX-ASSEMBLYDB O SULLA SCHEDULA DI PRODUZIONE) ................................ 33 

FIGURA 22: OUTPUT CORRETTO PER IL TEST LED-RPC ..................................................... 34 
FIGURA 23: TDC STATUS PER MB1................................................................................... 37 
FIGURA 24: TDC STATUS PER MB3................................................................................... 37 
FIGURA 25: PATTERN UNIT CALIBRATION PER UN MINICRATE MB1 ................................. 38 
FIGURA 26: PATTERN UNIT CALIBRATION PER MB2.......................................................... 39 
FIGURA 27: PATTERN UNIT CALIBRATION PER UN MB3 .................................................... 39 
FIGURA 28: ESEMPIO DI OUTPUT CORRETTO PER ILI TEST CPU CK PHASE (MB2): IL PRIMO 

GRAFICO IN ALTO MOSTRA IN QUALE TIME-SLOT DELLA PATTERN UNIT (PU INDEX) IL 
DATO E’ TROVATO CORRETTAMENTE IN FUNZIONE DELLA FASE DEL CLOCK ALLA CPU 
CHE INDUCE LO START DELL’EMULAZIONE DEI BTI . CIASCUN PLOT NELLA LEGENDA 
SI RIFERISCE AD UNA DIVERSA TRB. SI NOTI: LO SFASAMENTO DI 7 TIME-SLOT TRA LE 
BOARD PHI E QUELLE THETA; UNA REGIONE DI CIRCA 4 NS IN CUI LA TIME-SLOT NON 
E’ STABILE. QUESTA ULTIMA OSSERVAZIONE INDICA CHE LA FASE DEL CLOCK ALLA 
CPU NON ASSICURA CHE LE TRACCE SIANO EMULATE DAI DISPOSITIVI CON UN TIMING 
STABILE E CHE SIANO QUINDI ATTESE IN USCITA ALLA STESSA TIME-SLOT.  PER 
CIASCUN PUNTO VENGONO EMULATE 10 TRACCE. NEL SECONDO GRAFICO SONO 
MOSTRATI GLI ERRORI SECONDO IL CODICE NELLA LEGENDA A SINISTRA. POSSONO 
ESSERCI ERRORI TIPICAMENTE NELLA ZONA IN CUI IL CLOCK E’ CRITICO. SI OSSERVI 
COME PER UN VALORE DI 12 NS IL CLOCK E’ IN UNA REGIONE STABILE. ..................... 40 

 4



FIGURA 29: ESEMPIO DI CORRETTO OUTPUT PER IL TEST CPU CK PHASE (MB3)............. 40 
FIGURA 30: OUTPUT DEL TEST SERIALIZERS PER UN MB3. SI OSSERVI COME UN VALORE 

DELLA FASE DI CLOCK UGUALE A 0 (IL DEFAULT) SIA ACCETTABILE. 
L'INTERPRETAZIONE DEI PLOT E' SIMILE A QUELLI IN ERROR! REFERENCE SOURCE NOT 
FOUND.. OGNI PLOT SI RIFERISCE AD UNA DIVERSA TRB, MENTRE LA FASE DEL CLOCK 
E’ QUELLA ALLA SERVER BOARD............................................................................... 41 

FIGURA 31: ESEMPIO DI OUTPUT DEL TEST SERIALIZERS PER UN MB2: SI NOTI COME LA 
TRB5 (LA THETA 1 PER UN MB2) ABBIA SEMPRE ERRORI SU TUTTO L’INTERVALLO 
DELLO SCAN DI FASE. QUESTO INDICA UN MALFUNZIONAMENTO DELLA SCHEDA O UN 
DIFETTO NELLA CONNESSIONE DI ESSA ALLA SERVER BOARD INDIPENDENTE DALLA 
SINCRONIZZAZIONE RECIPROCA. ................................................................................ 41 

TABELLA 4: CONNESSIONE DEI CAVI FRONT-END THETA ................................................... 43 
FIGURA 32: CONNESSIONE DEI CAVI TEST-PULSE ............................................................... 44 
FIGURA 33: ESEMPIO DI OUTPUT PER IL TEST TP CABLE PER UN MB3.............................. 49 
FIGURA 34: OUTPUT DEL TEST DI BTI SKEW: OGNI CURVA SI RIFERISCE AGLI ERRORI (SU 

100 PATTERN PER PUNTO) ESEGUENDO UN TEST PULSE VARIANDO LA FASE DEL 
SEGNALE IMPULSATO SU UN BTI. COME SI VEDE DAI PRIMI DUE GRAFICI DALL’ALTO CI 
DEVE ESSERE UNA REGIONE IN CUI IL NUMERO DI ERRORI E’ INFERIORE A 10 (TRA 120 
E 180) E LE DUE ZONE IN CUI INIZIANO GLI ERRORI DEVONO ESSERE SOVRAPPOSTE PER 
TUTTI I BTI CON UNO SFASAMENTO DI 3-4 NS (RICORDA : 1 TICK NELL’ASSE X = 150 
PS). L’ULTIMO GRAFICO PERMETTE DI VISUALIZZARE LA CURVA SINGOLARMENTE PER 
CIASCUN BTI. ............................................................................................................ 49 

FIGURA 35: OUTPUT DEL TEST DI BTI SKEW: I DUE GRAFICI MOSTRANO IN ASCISSA IL BTI 
IMPULSATO COL TEST PULSE E IN ORDINATA IL VALORE DI DELAY SULLA FASE DEL 
TEST PULSEIN CUI GLI ERRORI VANNO A 0 (GLOBAL FALLING PLOT) E QUELLO IN CUI 
AUMENTANO (GLOBAL RISING PLOT). LO SFASAMENTO IN ORDINATA DI TUTTI I PUNTI 
DEVE ESSERE COMPRESO IN UN INTERVALLO TIPICO DI 3-4 NS. .................................. 50 

FIGURA 36: POSIZIONI PER INSERIRE I FERMACAVI SULLE STAFFETTE DI ALLUMINIO. IL 
FERMACAVO VA MESSO CON L’APERTURA RIVOLTA VERSO IL SUPERLAYER PHI 2..... 54 

FIGURA 37: POSIZIONE DEI DIVERSI FORI SULLA TESTATA DUMMY (FROM M.PEGORARO) . 64

 

 5



 6



1. Procedura di assemblaggio 
 

1.1. Preparazione preliminare 
 

• Disimballare da carta multiball tagliando lo scotch all’estremita’ 
• Riporre carta multiball per rimballaggio finale 
• Prender nota del minicrate e iniziare a riempire il file che conterra’ le 

informazioni di assemblaggio D:\Minicrate Docs\MBx-assemblyDB 
• Posizionamento: per i minicrate tipo Left il cavo di alimentazione deve essere alla 

propria sinistra, per i Right a destra. 
• Fissare con attenzione e scrupolo il cavo di alimentazione con scotch carta per 

evitare che si pieghi o tagli. 
• Togliere tutti i coperchi esterni svitando e togliendo tutte le viti. 

Togliere i coperchi per la dissipazione del calore se presenti (le viti vanno tolte). 
Attenzione: non far cadere le viti all’interno del Mini-Crate, altrimenti 
recuperarle e’ un lavoro improbo. 

• Stato del Mini-Crate quando arrivera’ da Madrid a regime: ROB, Link Board, 
CCB e SB saranno gia’installate. 

• Verificare Jtag Address sulle ROB(switch S1). Da Sx deve essere 0x8, 0x9, ecc. 
• Annotare numero seriale ROB nel file di assemblaggio. 
 
1.2. Preparazione dissipatori di calore per le TRB 
 
• Scegliere tutti i coperchi di dissipazione di calore ed i relativi distanziatori (2 per 

coperchio, uno con scanalatura ed uno senza). 
• Inserire distanziatori di alluminio (spacers) sotto i coperchi di dissipazione di 

calore. Verificare sulla TRB come va il listello (non e’ simmetrico e deve 
combiaciare con il sensore di temperatura posto sulla TRB). Attenzione alla forma 
dei coperchi. La sporgenza in un angolo dovra’ sovrapporsi al regolatore di 
corrente. 

• Avvitare gli spacers dalla parte dei coperchi che sara’ a contatto con le TRB,  
usando viti di tipo M3x6 nei quattro fori esterni (vedi cerchio rosso in Figura 1). 
La vite va inserita dalla parte del coperchio.  
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Figura 1: preparazione coperchi di dissipazione delle 
TRB 



 
1.3. Preparazione preliminare delle TRB 

 
• Estrarre dalle scatole tutte le TRB (sia PHI che THETA) che si prevede di 

installare nel minicrate (Figura 19 ) . 
• Sulle TRB c’e’ un jumper ,PN1,(vicino al connettore del clock per TRB-PHI128 e 

a destra del Traco, guardando la scritta del chip, sulla TRB-PHI32) che va 
oppurtunamente connesso (con stagno) per fissare lo shift bit per lo sfasamento 
dei superlayers.  
la regola da seguire per il jumper PN1 e': 
tutti i minicrate S+ jumper APERTO 
tutti i minicrate S- jumper CHIUSO(con goccia di stagno) 
tutti i minicrate S0 Jumper CHIUSO(con goccia di stagno) 
 

• Catalogare le TRB da inserire: segnare sulla tabella nel file di assemblaggio il 
numero seriale delle TRB e la relativa posizione in cui ciascuna verra’ montata, 
come da Figura 19: Minicrate Layout (connettori RJ451 sulla SB in alto). (il 
numero seriale e’ indicato dalle ultime 5 cifre sull’etichetta con codice a barre) 

 
• Togliere copertura switch SW1 e settare indirizzo Jtag delle TRB. 

 
Attenzione: indirizzo JTAG sulle TRB PHI va settato sullo switch SW1 
identicamente al numero del connettore a cui e’ connessa sulla SB (Figura 
20). Indirizzo JTAG delle TRB THETA: partendo da sinistra la prima e’ 0x7 
la seconda 0xF. 
N.B.: switch SW1, quando l’interruttore e’ sul lato ON il circuito e’ chiuso; 
circuito aperto = 1, circuito chiuso= 0). => ON = 0; 
Sulle TRB PHI-128 e sulle TRB THETA i 4 bit (A0 A1 A2 A3) sono indicati 
sulla serigrafia, mentre sulle TRB-PHI 32 guardando lo swich tenendo i BTI 
a sinistra il primo a sinistra (interruttore 4) e' A0 poi A1 ecc. 

 
• Controllare JTAG address suò dip switch con il tester (~0 Ohm = chiuso = 0, ~10 

Kohm = aperto = 1) 
 

1.4. Inserimento TRB 
 
• Le TRB vanno inserite da sinistra, come Figura 20 (connettori RJ45 sulla SB in 

alto). 
• Inserire connettori End Trigger Bus sulle due TRB che verranno inserite alle 

estremita’ del minicrate, prestando attenzione all’esatta forma dei connettori, (ve 
ne sono 2, uno left ed uno right) limando leggermente via dalle piastrine di 
terminazione del bus TRB lo scoring in eccesso. In questo modo il dissipatore del 
BTI non entra in contatto con la piastrina e non forza il connettore relativo. 

• Prendere la prima TRB da inserire. 

                                                 
1 Sono i connettori identici a quelli Ethernet standard. 
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• Preformare il cavo di capton per il Trigger Bus e connetterlo al connettore right 
della TRB prima di inserirla nel Mini-Crate. 

• Inserire la TRB, verificare la coincidenza tra i connettori ROB-TRB; verificare 
che non vi siano cavi schiacciati tra le due e infine premere la TRB in 
corrispondenza dei connettori con la ROB, cosi’ da connetterle. 

• Connettere alimentazione (cavo 4 fili) e clock (cavo 2 fili) che sono in prossimita’ 
dei connettori dedicati. 

 

 
Figura 2: Inserimento TRB; si noti l’End Trigger Bus (verde) e il Trigger Bus (rosso). 

 
• Ricontrollare JTAG address  
• Inserire la TRB successiva. 
• Connettere il Trigger Bus con la precedente. 
• Per estrarre la TRB (in caso di necessita’!) conviene usare due dita, nello 

stesso lato in corrispondenza delle sporgenze della board dove vi sono i 
connettori ROB-TRB. 

• Mettere tutte le TRB, prima le PHI poi le THETA, sempre da sinistra a destra 
secondo il layout del Mini-Crate (Figura 20). 

• Inserire tutti i cavi capton del Trigger Bus, tra tutte le TRB e anche i due verso la 
SB (sia da inserire o gia’ presente). 

• Sull’ultima TRB THETA inserire la terminazione right del Trigger Bus se non 
gia’ fatto in precedenza . 

 
1.5. Assemblaggio CCB  

 
• ANNOTARE numero seriale CCB nel file di assemblaggio !!! 
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• Connettere cavi slow control PHI1, PHI2 e CCB (vedi Figura 3 , Front End I2C) e 
cavo soglie (connettore threshold sulla serigrafia) prima di inserire la CCB nel 
minicrate 

 

 
 
 
 
 

        PHI1   PHI2    cavo piu’ corto con massa  verso il lato CCB 
 
 

Figura 3: CCB cables connections 

 
• Connettere alimentazione CCB (uno dei due connettori di alimentazione a 4 poli, 

l’altro e’ per la SB)  e cavo ROBUS (grigio, sotto la CCB) 
• Inserire la CCB prestando attenzione a mantenere tutti gli altri cavi sopra di essa. 
• Tenere la scheda aderente al Mini-Crate nel lato opposto ai connettori rossi ed 

infilare i cavi del clock (CK ROB e CK TRB in Figura 3) che passano sotto la 
scheda. 

• Inserire cavo di connessione con la link (cavo dorato piu’ grande) nel connettore 
in alto a destra; quest’ultimo passera’ sopra la SB. 

• Inserire cavi allineamento e RPC (1°  e 3° piccolini da sx in alto) (allineamento ce 
ne va uno solo). Cavi allineamento e RPC scorrono nel Mini-Crate in direzione 
Link Board (vedi Figura 4), quello allineamento deve uscire da sopra la CCB 
sopra quello RPC ( Figura 5). 
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RPC

Alignment 
TTC optical connection 

Figura 4: posizione connettori RPC e Allineamento 

 
Figura 5: routing cavo RPC in uscita dalla CCB. 

 
 
• Fissare CCB con listelli di alluminio (SB spacers), prestando attenzione all’esatto 

posizionamento, in quanto non sono ne’ interscambiabili ne’ simmetrici. 
(utilizzare viti M3x16 con testa svasata o conica ) 
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1.6. Inserimento SB 
 
• ANNOTARE numero seriale SB nel file di assemblaggio !!! 
• Controllare che SB abbia la EPROM  inserita nello zoccolo (ce ne e’ uno solo nel 

lato opposto a quello coi connettori RJ45).  
• La SB va inserita con i connettori RJ45 in alto.  
• Prima va inserita l’alimentazione poi si verifica il posizionamento e la misura dei 

cavi (soprattutto quelli che escono dalla CCB, come RPC e allineamento, vedi 
Figura 6, Figura 7) 

 

 
Figura 6: Cables routing in uscita dalla SB.  Dettaglio su cavi RPC e Allineamento. 

 
 

• Inserire, verificare corrispondenza connettori con la CCB e spingere per inserire i 
connettori. 

• Avvitare le viti (M3 x 6) per fissare la SB. 
• Inserire e connettere i Trigger Bus tra la SB e le TRB adiacenti. 
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Figura 7: Posizionamento SB 

1.7. Montaggio coperchi per la dissipazione 
 

• Preparare la gomma termoconduttiva, spessore 2mm da attaccare sotto i 
coperchi per la dissipazione del calore (sopra tutte le TRB) 

 

 
Figura 8: Aderimento della gomma termoconduttiva. 

 
• Misure foglio di gomma acquistati: 200 x 300 mm (A4) 
• Dimensioni gomma da applicare ai coperchi: 53 x 211 mm (trb phi128 e 

theta), 53 x 70 (trb phi 32: NB: 70 e’ indicativo, deve comunque coprire la 
superficie dei BTI).  
Attenzione! Tagliare la gomma senza tagliare la plastica protettiva. La 
plastica va tolta solo all’ultimo momento nell’inserimento per non 
lasciare impronte. 
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• Prestare attenzione all’aderenza della gomma durante e dopo la fase di 
aderimento (Figura 8) 

• Dopo aver messo la gomma per la dissipazione di calore per i BTI, pulire con 
l'alcool la superfice su cui poi si incollano le graffette per tenere fermi i cavi 
TRB. Si evita che la graffetta si stacchi causa sporcizia oleosa portata dalle 
dita (o gia presente) quando si inserisce il gap filler per il raffreddamento BTI. 

 

 

 
Figura 9: Gomma termoconduttiva sui regolatori di tensione della TRB. 

 
• Mettere la gomma termoconduttiva (spessore 1 mm) direttamente sopra il 

regolatore di tensione delle TRB. La dimensione e’ di circa 1cm x 1 cm 
(Figura 9). 

• Mettere il coperchio di dissipazione prestando attenzione al posizionamento: 
non e’ simmetrico in quanto ha una parte sporgente che va posizionata sopra il 
regolatore di tensione delle TRB. 

 
• Alcune  schede TRB potrebbero avere una riparazione fatta con un filo che 

passa sopra la zona in cui si appoggia il distanziatore tra scheda e dissipatore 
BTI; tale filo non va schiacciato, praticando una piccola scanalatura con la 
lima nel distanziatore. 

 
 
• Inserire tutte le viti senza stringerle; vi sono due tipi di viti: M3x25 vanno nel 

foro in corrispondenza con quello dei listelli di alluminio (i 4 piu’ centrali, 
cerchio verde nella foto in Figura 10) , M3x6 negli altri (cerchi rossi nella foto 
in Figura 10). 
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Figura 10: Viti per il fissaggio dei coperchi di dissipazione delle TRB. 

 
 

• Stringere tutte le viti iniziando dalle 4 negli angoli esterni. 
 

1.8. Cablatura cavi Trigger tra TRB e SB 
 

• Scegliere i due cavi TRB-SB della TRB piu’ a sinistra nel Mini-Crate: i codici dei 
cavi da utilizzare sono indicato nello schema col layout dei Mini-Crate (Figura 
20). 

 
• E’ buona norma inserire i cavi in modo che la sigla su di essi sia leggibile da parte 

di chi li mette. 
• Inserire entrambi i connettori del lato SB, la coppia di cavi deve assolutamente 

avere il filo rosso dalla stessa parte (a sinistra). 
 

• Piegarli entrambi contemporaneamente a 90° nella direzione della TRB 
corrispondente (Figura 11 e Figura 13). 

 
• Il routing dei cavi e’ indicato nello schema col layout dei Mini-Crate (Figura 20). 
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Figura 11: Cavi trigger sul lato SB 

• Preparazione Cavi lato TRB: 
Il cavo che sulla SB corrisponde al connettore che sta sopra, quando viene 
rigirato, va sotto e va inserito nel connettore della TRB che sta sotto 
Sul lato TRB prima rigirare il cavo che sta sotto e che andra’ connesso  al 
connettore inferiore. 
Girare il cavo rimasto che andra’ connesso al connettore superiore. 
(vedi Figura 12 e Figura 13) 

 
• I due cavi sul lato TRB (vicino al connettore) vanno pre-formati con una 

gobba, come si intravede nella foto in Figura 12, in modo che il cavo stia 
leggermente rialzato rispetto alle due viti a cui passera’ sopra. Attenzione: il cavo 
e' un po' delicato e soprattutto se si rovina il taglio a croce della vite c'e' il 
rischio che bordi taglienti danneggino il cavo, quindi prestare attenzione quando 
quelle viti sono avvitate anche se in genere il cavo si appoggia solo 
sul bordo tondeggiante della vite stessa. 
Per preformare il cavo vi sono due alternative:  

1. dopo aver fissato il primo connettore si appoggia sotto al cavo e sopra le 
viti uno spessore liscio tondeggiante per fare la gobba cercando di evitare 
di tirare/forzare il cavo sul lato del connettore;  

2. cercare di formare il cavo prima di inserirlo: e' meno rischioso ma piu’ 
difficile ottenere la giusta forma della gobba. 

 
• Connettere il cavo che sta sotto al connettore inferiore. 
• Connettere il cavo rimasto al connettore superiore. 
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Figura 12: Cavi di trigger lato TRB; si noti che essi sono pre-formati in vicinanza dei connettori. 

 
• Connettere tutti i cavi per tutte le TRB da sinistra a destra prestando attenzione sia 

ai  i codici dei cavi da utilizzare che al routing, come indicato nello schema col 
layout dei Mini-Crate ( Figura 20). 

 
• Inserire per ultimi i cavi delle TRB Theta; arrotondare tutta la chiave del 

connettore con un cutter dalla parte SB, per permettere l’inserimento e 
l’estrazione in corrispondenza del passaggio del cavo link. 

• Fermare i cavi con gli appositi fermacavi. 
 

 
Figura 13: Connessioni e disposizione dei cavi di trigger: particolare. 

 
 

1.9. Cablatura cavi dalla CCB  
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• Stendere i cavi dorati in direzione della Link Board, prima quello RPC-

allineamento poi il link. Notare il routing in Figura 6. Il cavo allineamento e’ 
sopra e sopra rimane dopo le due pieghe a 90 gradi (piegare entrambi i cavi 
contemporaneamente) 

 
• Inserire (se non lo e’ gia’) il connettore esterno per i cavi RPC e allineamento, nel 

lato del Mini-Crate della Link Board (Figura 14) 
• Connettere i cavi RPC e allineamento seguendo un percorso attorno alla Link 

Board (dalla parte piu’ lunga, vedi Figura 14). 
 

 
Figura 14: Connettore RPC-Allineamento e routing dei cavi attorno alla Link Board. 

 
• Il cavo piu’ corto va inserito nel primo connettore e il piu’ lungo nell’altro. 

 
1.10. Inserimento Link Board 

 
• Scegliere la link Board, ANNOTARE numero seriale nel file di assemblaggio 

se c’e’ l’etichetta, altrimenti procedere senza annotare il numero. 
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Figura 15: Staffette della Link Board 
 
 

• Fissare le due staffette ( Figura 15), quella piu’ grande va inserita attorno al 
connettore per il cavo ottico TTC (vedi anche Figura 4), quella piu’ piccola va 
nell’altro lato della board. 

• Inserire la rondella attorno al connettore per il cavo ottico TTC. 
• svitare leggermente le viti che tengono il coperchio laterale del minicrate (quello 

dove si fissano i connettori RPC e allineamento) perche' tendono a restringere il 
minicrate; in questo modo si favorisce l’inserimento della link board. 

• Connettere il cavo dorato dalla CCB nel connettore posto al di sotto della scheda. 
(vedi Figura 14 per l’inserimento e Figura 16 per il routing) 
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Figura 16: Routing del cavo Link sopra la SB. 

 
 

• Inserire la Link Board e fissare le staffette al minicrate con viti tipo M3x12 per la 
staffa sotto al connettore TTC e M3x8 per l’altra. Attenzione a non far cadere le 
viti di fissaggio che sono in posizione delicata 

• Riavvitare le viti che fissano il coperchio dove sono avvitati i connettori RPC e 
allineamento. 

 
1.11. Connessione dell’alimentazione 
 

• Alimentazioni Mini-Crate 
o 2 cavi rossi piu’ spessi: 3.3 V 
o 2 cavo neri piu’ spessi: massa della 3.3 V 
o 1 cavo arancione : 5 V 
o 1 cavo viola o  blu (eventualmente con guaina nera): massa 5 V 

• Mettere capicorda ai cavi se non ci sono gia’: per quelli spessi usare quelli 
gialli con l’occhiello piu’ piccolo GF-M3, per gli altri due quelli rossi RF-M3 

 
1.12. Prima accensione e programmazione preliminare degli FPGA 

 
• Connettere Byte Blaster (che e’ connesso con cavo flat azzurro alla porta parallela 

del PC windows, c’e’ anche scritto il nome sul connettore a fine cavo.)  al 
connettore BITBL sulla Server Board. 

• Connettere cavo RS-232 alla Link Board 
• Accendere alimentatori per 3.3 V e 5 V. 
• Gli assorbimenti dovrebbero essere ~0.7 A sulla 3.3 e ~0.5 sulla 5. 
• Lanciare programma Altera/Quartus II (digitare NO se chiede di aprire un nuovo 

progetto) 
• Nei Recent Files aprire il file Chain SB_CCB. 
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• Si aprira’ il programmer con 3 devices presenti. 
• Selezionare Verify per tutte e tre e premere Start 
• Se fallisce nella verifica della Device #3 effettuare la seguente operazione: 

o Selezionare Program/Configure per la device #3 e lasciare in tutte il 
verify, poi premere Start. 

o Verificare il successo dell’operazione 
• Chiudere il programma Quartus II. 
• Spegnere la 5 V 
• Poi spegnere la 3.3 V 
• Togliere il cavo Byte Blaster. 

 
1.13. Programmazione FLASH 

 
• Inserire la fibra ottica dal TTCex nel connettore del TTC sul minicrate (Figura 4). 
• Accendere il crate col TTC e abilitare lo switch ON del laser sul TTCex (si 

accendera’ la spia rossa con scritto “danger lasers on”. 
• Lanciare Monitor 7. 
• Connections -> MC settings deve eessere su Secondary Port. 
• Verificare che in Com Setup  sia selezionata COM1.  
• CCB Identifier deve essere 0xFFFF. 
• Accendere prima la 3.3V e poi la 5V 
• Verificare Output del programma di Boot su Monitor 7 (confronta con Figura 17) 

 
• Annotare nel file assemblyDB l’identificatore della CCB, espresso in 

esadecimale. 
• Su Monitor 7 : File -> Unprotect Flash (verificare output Flash 

UNPROTECTED). In caso di errore File Æ Int Wd Reset 
 
Attenzione: l’errore si verifica perche’ la Flash si puo’ programmare solo quando 
il minicrate e’ in programma di Boot. Se invece e’ gia’ in programma di 
funzionamento del Minicrate (parte dopo 30 secondi da quando il minicrate e’ in 
programma di Boot se non riceve altri comandi dall’esterno), bisogna attendere 
che finisca di caricarlo e forzare un reboot (File Æ Int Wd Reset).  
Prima di programmare la Flash il minicrate puo’ andare in reboot 
automaticamente, questo perche’ la versione del firmware presente e’ obsoleta. E’ 
necessario premere File -> Unprotect Flash per programmare la versione corretta 
subtio dopo la visualizzazione dell’output del programma di Boot. 
 

• File -> Write Flash  
• Nella finestra ceccare SetWriteAddr e QuickVerify, WriteStartAddr deve essere 

80000 e selezionare file D:\Minicrate Tools\Firmware\Cb_vxx_flash.s19 
Importante: xx sono due cifre che indicano la versione del firmware. 
Va utilizzato il file nella directory con la versione piu’ recente (al 20 giugno e’ 
la 19). 
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• Attendere il completamento e selezionare File -> Protect Flash (verificare output 
Flash PROTECTED). 

• File->Int Wd Reset, verificare output : CCB resetting 
• Verficare che l’output del Boot sia Ok e attendere che sia terminato il programma 

di test del Minicrate: la corrente deve essere stabile attorno al valore di 
riferimento per ciascun tipo di Minicrate (vedi tabella ). 

Tabella 1: Corrente assorbita dai Minicrate (valori di riferimento) 

Camera I (5V) I (3.3V) 
MB1 1.2 21.8 
MB2 1.2 24.0 
MB3 1.2 28.0 
MB4(9-11) 1.2 12.6 

 
 
CCB_ID=0x…. 
Version=3.9 
IUart_Test=OK 
EUartA_Test=OK 
EUartB_Test=OK 
EUartIRQ=OK 
RamTest=OK 
FlashTest=OK 
AutoRun=ON 
TTCrx=OK 
TTCi2c=OK 
TTC_ck=OK 
PwrRam=[1]OK 
ErrRam=0 
VErrRam=0 
PwrFlash=[1]OK 
FlashID=1FDA 
LINK_AUTOSET=OK (FAIL se la connessione ottica al minicrate non e’ presente) 
…….. 
PwrAnalog=[1]OK 
CpldTtc=OK 
QPLLA=UNLOCK 
QPLLA Change=STABLE 
QPLLB=UNLOCK 
QPLLB Change=STABLE 
Vccin=6.22    (valori indicativi) 
Vddin=4.45   (valori indicativi) 
Vcc=4.97      (valori indicativi) 
Vdd=3.27      (valori indicativi) 
Vtp1H=3.11            (valori indicativi) 
Vtp1L=1.89      (valori indicativi) 
Vtp2H=3.10           (valori indicativi) 
Vtp2L=1.87            (valori indicativi) 
 

Figura 17: Esempio di riferimento di corretto output per il programma di BOOT 
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• Spedire al Minicrate il comando Status e verificare che ritornino i dati. 
• Confrontare l’output con i valori di riferimento in Figura 18 

 
Ccb_ID=.. 
HVersion=1   (prima cifra della versione del firmware ; in questa figura e’ la versione 1.9) 
LVersion=9   (seconda cifra della versione del firmware) 
McType=  ..    (tipo del minicrate; se non e’ corretto puo’ essere dovuto a problemi sulle TRB o sulle ROB       
che non si accendono correttamente ) 
PwrAn=ON 
PwrCK=ON 
PwrLed=ON 
PwrRpc=ON 
PwrTrbBuf=ON 
PwrTrbVcc=ON 
PwrSO=ON 
PwrDU=ON 
PwrDD=ON 
PwrSBCK=ON 
PwrTH=ON 
TTCrdy=ON 
PwrFlash=OFF 
EnTtcckMux=ON 
QPLL1_rdy=FAIL 
QPLL2_rdy=FAIL 
PwrTrb=   (0xCF -> mb1 e mb2    0xDF -> mb3) 
PwrRob=  (0x3F -> mb1 e mb2    0x7F -> mb3) 
AlrmPwrAn=OK 
AlrmPwrCK=OK 
AlrmPwrLed=OK 
AlrmPwrRpc=OK 
AlrmPwrTrbBuf=OK 
AlrmPwrTrbVcc=OK 
AlrmPwrSO=OK 
AlrmPwrDU=OK 
AlrmPwrDD=OK 
AlrmPwrSBCK=OK 
AlrmPwrTH=OK 
AlrmTTCrdy=OK 
AlrmPwrFlash=OK 
AlrmB1w=OK 
…… 
AlrmPwrTrb=0x00 
AlrmPwrRob=0x00 
AlrmTempTrb=0x00 
AlrmTempRob=0x00 
Vccin=    (> ~ 5 V e < ~ 6.2 V ) 
Vddin=(> ~ 3.8 V e < ~ 4.1 V ) 
Vcc= (~ 5V) 
Vdd= (~3V ) 
 
Figura 18: Valori di riferimento per l'output del programma del Minicrate 
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1.14. Test del Boundary Scan 

 
• Verificare che in Monitor7 Connections->Server Settings sia abilitato e la porta 

sia 18889. 
• Editare il file D:\Minicrate qualification Test Stand\ConfigurationParameter.txt 
• Il parametro CCB_COMM_ADDRESS  deve avere il valore 0xFFFF. 
• Il parametro SERVER_SAME_AS_CLIENT deve essere ‘yes’ 
• Verificare i seguenti parametri: 

o CHECK_TRB yes 
o CHECK_TRB_THETA yes 
o CHECK_ROB_TRB yes 
o CHECK_SB yes 

• Lanciare il programma D:\Minicrate qualification Test Stand\Test Boundary Scan  
• Attendere la fine (circa 15-20 minuti) 
• Verificare che nel file BoundaryScanLog_xx con xx l’identificatore della CCB in 

decimale che nelle ultime righe non segnali la presenza di errori. 
 

1.15. Spegnimento 
 

• Spegnere prima la 5 V, poi la 3.3 V. 
• Disabilitare lo switch ON del laser sul TTCex (si spegnera’ la spia rossa con 

scritto “danger lasers on”. 
• Chiudere il Monitor 7. 
• Staccare cavo RS-232 alla Link Board 

 
1.16. Chiusura dei coperchi 

 
• Prima di inserire i coperchi, stringere bene tutte le viti dei dissipatori se non lo 

sono gia’. 
• Prima di inserire il coperchio bisogna eventualmente limare un foro, dalla forma 

circolare tipo-Lemo a semicerchio (nel caso non sia gia’ della forma giusta). 
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• Coperchio SB: 1) mettere linguetta alluminio dove escono i cavi slow controls 

63x80 mm  2) tagliare ed inserire una protezione di plastica di 42 mm 
• Mettere protezioni con linguette di alluminio autoadesive anche sui coperchi 

di TRBtheta e TRBphi32 (la parte di alluminio autoadesiva va rivolta 
all’esterno e fissata al coperchio con una protezione di plastica)  

• Inserire prima tutti i coperchi e solo alla fine stringere tutte le viti 
• N.B.: quando si chiude il coperchio sulla SB bisogna ricordarsi di avvitare la 

forcella del cavo I2C degli slow control (che e’ connessa a massa) sotto la vite 
di fissaggio del coperchio piu’ vicina. 

• Mettere le 3 etichette sul minicrate 
1: a lato, sopra l’uscita del cavo di alimentazione; 
2: a fianco dei connettori RJ45 sopra il coperchio della Server Board; 
3: a fianco dei connettori per i cavi di uscita del read-out. 

• Controllare i fissaggi alle 2 estremita’. Se non sono dell’ultimo tipo sagomato 
con rientranze angolari, sostituirli (non in MB1) 

 
1.17. Note generiche di vario interesse sul Minicrate 

 
• Il sistema di test del minicrate prevede dal server di interfaccia col minicrate tre 

interfacce seriali (il valore della porta COM e’ come connesso nel setup di 
Bologna) 

COM x -> RS232 -> Ottico -> Mini-Crate (connessa al server sul PC 
linux) 
COM x -> RS232 -> RS485 -> Mini-Crate (connessa al server sul PC 
linux) 
 
COM 1 -> RS232 -> Mini-Crate 
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• La caduta di tensione sul cavo e’ importante: o si usa il sense o si tiene piu’ alta, 
comunque se le schede si spengono puo’ convenire regolare la tensione; la 
procedura e’ spegnerle tutte, accenderle una per volta verificando che la tensione 
non scenda molto (per le ROB circa 3.8 V) e nel caso alzare leggermente prima di 
accendere la scheda successiva. 

• Lato Theta scalda piu’ di lato Phi; circa 4 °C  (logica discreta ECL) 
• A 50 °C scatta la protezione del Mini-Crate che spegne le ROB e TRB 

 
 
 
 
 

 
 
 
 
 

 26



 
Figura 19: Minicrate Layout 
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Figura 20: TRB cables routing 
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2. Istruzioni per il Test Pre-Dressing  
 

2.1. Istruzioni preliminari 
 
• Connettere le alimentazioni (5V , 3.3V) se non lo sono gia’. 
• Connettere fibra TTC, fibra RS232 Ottica, e RS485 (vedi Figura 21). Riguardo alla 

RS485 i due connettori sono equivalenti. 
• Accendere i crates VME. 
• Connettere i cavi dello schedino di test per RPC e Led di allineamento. Il connettore 

del cavo ha una chiavetta dipinta di bianco. Questa va inserita in corrispondenza della 
scanalatura per la chiave nel connettore sul minicrate. 

• Connettere i cavi di trigger e di read-out. 
 

 
Figura 21: Link Board Connections (both RS485 connectors are equivalent) 

 
2.2. Accensione DAQ 

 
• Connettersi su pccmslab. User:daqcms   Passw: daqcms 
• Aprire xterm.  
• Digitare comando ‘daqstart’. 
• Aprire un nuovo xterm. 
• Digitare comando ‘guireset’ e attendere l’apertura dell’interfaccia grafica. 
• File ->Login. 
• User: root. Passw: xxx 
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• Tools -> Run Control ; attendere che si apra l’interfaccia grafica del run control. 
• *) Sulla finestra di run control: Session -> Open. 
• Selezionare il file DAQ e premere Open. 
• Se non e’ attivo il pulsante Configure, bisogna fare: Session ->Destroy e poi ripetere 

da *). 
• Ceccare l’opzione test-Minicr 
• Premere pulsante Configure (verificare che il led verde sulla ROS nel crate lampeggi) 
• Premere pulsante Start 
 

2.3. Pre-accensione 
 
• Abilitare lo switch ON del laser sul module TTCex (spia rossa accesa). 
• Accendere la linea di alimentazione degli alimentatori del front-end e del modulo per 

la connessione ottica al minicrate. 
• Accendere alimentatore minicrate per la 3.3 V 
• Verificare che siano accesi i moduli per le connessioni ottiche (a fianco degli 

alimentatori per il front-end) e RS485 (a fianco del video di pccmslab)  con il 
minicrate e che non vi sia acceso il led rosso del modulo RS485 (se e’ acceso, 
premere il pulsantino di reset di color rosso posto vicino al led) 

 
2.4. Test – procedura sequenziale  

 
• Lanciare il programma ‘mc_test’ sul pc windows utilizzando lo shortcut sul desktop. 
• Lanciare il programma utilizzando la freccia bianca in alto a sx nella finestra. 
• Digitare nella nuova finestra il tipo di minicrate (es: mb1 , mb2, ...) e l’ID del 

minicrate (e’ nel file assembly-DB, sono le ultime 5 cifre del numero che lo identifica 
e che e’ riportato sull’etichetta). 

• Sulla finestra principale, nel pannello di start-up premere il pulsante START MC. 
• Rispondere OK. 
• Finestra check_daq: premere ; attendere il messaggio ‘Check Done’ ;  

in caso di errore verificare la connessione con la daq (....) e/o disabilitare il firewall. 
 
• Se tutto e’ ok ,premere OK e poi premere la freccia in alto (secondo tasto in alto a 

sinistra) . 
•  Comparira’ una finestra con scritto: Trying to connect to CCB. 
• Accendere l’alimentatore per la 5 V e poi premere OK. 
• Veficare che compaia scritta “CCB stopped on boot program” e premere OK 
• Il programma compie in automatico un check delle comunicazione con il minicrate 

(porta primaria ottica e secondaria RS485) premere OK entrambe le volte. 
• Si aprira’ la finestra di status_boot_display, premere e attendere messaggio 

‘Ok. Boot data were found.’ e poi verificare lo stato del boot (spia Boot Status verde, 
nessuna spia rossa in tutti i pannelli) 

 
• Premere 
• SI apre finestra con scritto ‘Starting minicrate program, etc...’, premere OK e 
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attendere. 
• Si apre una finestra con messaggio ‘Select...’, premere OK. 
• Premere pulsante START TEST e attendere che compaia il pop-up ‘Test Finished. 

Etc….’, premere OK. 
• Le uniche spie rosse accese (oltre alle due TestSB Err e Test Error nel pannello 

principale) dovranno essere quelle nel pannello SB test alla voce ADC noise.  
Nel pannello TRB test potrebbero esseci dei led rossi accesi nel quadrante PI test. 
Essi corrispondono ai connettori della Server Board in cui non sono collegate TRB 
(dipende dal layout del minicrate). Se a sinistra della riga di led rossi ce n’e’ uno 
verde vuol dire che tutto va bene. 

• Premere pulsante CLOSE VI 
• Al pop-up ‘Starting FEB test’, premere OK e attendere il pop-up ‘Test Done’ e 

premere OK. 
• Tutti i led devono essere bianchi. 
• Premere pulsante CLOSE. 
 

2.5. Configurazione Dispositivi 
 
• Pannello di Start-Up, premere pulsate Configure MC, premere OK al pop-up.   
• Nella finestra config_minicrate premere il led (che e’ spento) select ALL;  
• Premere i led Frontend e Width spegnendoli 
• Premere pulsante CONFIGURE. 
• Selezionare il file di configurazione (in D:\test mc\config_files): 
 
Minicrate Type Folder File 
MB1 mb1 Cfg1_c_mb1.cfg 
MB2 mb2 Cfg1_c_mb2.cfg 
MB3 mb3 Cfg1_c_mb3.cfg 
MB4 (9-11)   
 
• Premere OK e attendere fino al pop-up ‘Configuration Done’; nel frattempo verificare 

che non si accendano spie rosse. 
• Premere OK al pop-up Configuration Done. 
 

2.6. Impostazione del timing sulle TRB 
 
• Lanciare Monitor 7 
• Connections -> MC settings; CCB Port deve essere su TCP/IP Port. 
• Remote Host deve essere pccmslab.bo.infn.it 
• CCB Identifier deve essere 0x0. 
• Spedire al Minicrate il comando TTC_FineDelay con il primo parametro (char ch) 

uguale a  0 e il secondo uguale a 4.0 
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• Ora l’utente ha la scelta di quali test fare e quando farli partire. Tra un test e il 
successivo, verificare nel pannello Start-Up, premendo il tasto Show Detail lo stato 
del minicrate. 
I led Rossi presenti devono essere imputabili solo alla non connessione con il front-
end. (es: temperatura e tensioni front-end, splitter board, etc..) 
Nel campo BoardMaxTemp si puo’ vedere la temperatura massima raggiunta 
dal minicrate. Verificare che essa non superi i 48 gradi. Nel caso spegnere il 
minicrate, attendere una decina di minuti e ripetere le procedura sequenziale di 
test. 

 
2.7. Elenco Test da Effettuare 

 
Importante: in molti test compare un pulsante con scritto ‘jpeg’. Esso puo’ essere 
utilizzato per salvare un’immagine del programma di test alla fine di ogni singolo test. 
E’ vivamente consigliato utilizzarlo alla fine di ogni test per fare un’immagine di ogni 
schermata della finestra.  
Puo’ essere ripetuto piu’ volte, il pulsante crea una nuova immagine e non sovrascrive la 
precedente. 
Le immagini sono salvate in D:\mc_test\TEST_DATA; si trovano tutti i folder (sono del 
tipo mbx_nn, con x tipo del minicrate e nn il numero seriale) con le immagini ed i 
logfiles.  
 

2.7.1. Check TDC status 
 
• Nel pannello FE/TDC premere pulsante TDC display. 
• Premere freccia dx e poi pulsante Update in basso. 
• Verificare stato dei TDC (foto in appendice,vedi Figura 23 per Mb1, Figura 24 per 

Mb3).  
• Premere pulsante CLOSE, una volta sola! 
• Premere freccia in alto. 
 

2.7.2. Calibrazione della Pattern Unit 
 
NB: tale test, in linea di principio, fornisce una calibrazione per il sistema di acquisizione 
che varia solo da un tipo di minicrate all’altro. Per questo i valori del test possono essere 
salvati in un file di configurazione dell’intero software che vengono caricati ogni volta 
che parte il test. Nel pannello Set-Up verificare che i valori in “PU conf” siano accettabili 
per il tipo di minicrate. In caso di dubbio effettuare il test qui descrittto. 
  
• Nel pannello Minicrate Tests, sottopannello Calibration  premere pulsante PU timing  

Test. 
• Premere freccia dx e attendere stato READY. 
• Verificare che i pulsanti ‘start delay?’, ‘clock phi?’ e ‘clock theta?’ siano verdi, se 

non lo sono premerli per abilitarli. 
• Premere pulsante TEST e attendere. 
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• Si aprira’ un pop-up in cui chiedera’ di inserire un valore di clock delay. Osservando i 
grafici nel pannello PU clock delay, scegliere un valore comune in cui non vi siano 
errori (vedi Figura 25 per MB1, Figura 26 per MB2,  Figura 27 per MB3).  
Conviene mantenersi verso valori inferiori al centro dell’intervallo. 
Es: per MB1 : tipico 15-18 ns , comunque conviene  ≤ 20 ns 
Per MB2 tipico e’ 18 ns, comunque ≤ 20 ns 
Per Mb3 tipico e’ 23-25 ns, comunque ≤ 25 
  

• Dopo aver cliccato OK, attendere che si apra una finestra in automatico e poi si 
richiuda da sola. 

• Premere freccia a sx poi freccia in alto. 
 

2.7.3. Test TDC crosstalk 
 
• Nel pannello  Minicrate Tests, sottopannello TP/TDC premere pulsante Test TDC 

Crosstalk. 
• Premere freccia dx. Attendere alcuni secondi e premere il pulsante Test. 
• Attendere che siano aggiornate le tabelle nel primo pannello. 
• verificare che su ciascuna riga (= Evento) i numeri sulle colonne (= ROB) siano 

uguali (per le due tabelle rispettivamente). 
La prima tabella si riferisce al bunch counter per ciascun evento acquisito mentre la 
seconda all’event number. 

• Premere freccia sx e poi freccia in alto. 
 

2.7.4. Test TRB switch 
 
• Nel pannello  Minicrate Tests, sottopannello TRB premere pulsante Test TRB 

Switch. 
• Premere freccia dx.  
• Chiedera’ il segno dello shift dei superlayer relativo al minicrate. 
 
Minicrate Type SL Shift 
MB1 – L S- 
MB1 – R S+ 
MB2 – L S+ 
MB2 – R S- 
MB3 – L S0 
 
Tabella 2: segno dello shift dei superlayer in funzione del tipo di minicrate (per gli MB4 riferirsi al 
valore dello shift indicato sull’etichetta, sul file MBx-assemblyDB o sulla schedula di produzione) 

• Inserire il segno (S+,S-,S0) come indicato nella prima colonna in Tabella 2.  
• Attendere che sia aggiornata la finestra. 
• Per ciascuna TRB-PHI il programma verifica che la scheda sia presente e controlla lo 

stato dello switch chiuso o meno con stagno durante l’assemblaggio. 
Il numero di TRB-PHI dipende dal tipo di minicrate. 
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Lo stato dello switch dipende dallo shift dei superlayer e deve essere: 
S+ switch APERTO 
S- switch CHIUSO 
S0 switch CHIUSO 

 
• Premere freccia sx e poi freccia in alto. 
 

2.7.5. Test Led_RPC: 
 
• Nel pannello  Minicrate Tests, sottopannello Test I2C COM premere pulsante Test 

Led-RPC 
• Premere freccia dx.  
• Attendere che siano aggiornata la finiestra. 
• Verificare che si sia accesa la luce verde di Test OK. 
• Se non si e’ accesa, verificare che i dati siano come in Figura 22. 
 

 
Figura 22: Output Corretto per il test Led-RPC 

 
• Premere freccia sx e poi freccia in alto. 
• Dopo questo test ci potrebbe essere un errore nello Status del MC in quanto vengono 

spente le alimentazioni per i Led e gli RPC. 
 

2.7.6. Test CPU Clock phase 
 
• Nel pannello  Minicrate Tests, sottopannello Miscellaneous  premere pulsante Test 

CPU CK Phase 
• Premere freccia dx.  
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• Attendere che nel campo “message” sia scritto READY. 
• Premi il pulsante TEST. 
• Attendi il completamento di tutte le tracce. 
• Ogni plot corrisponde ad una traccia emulata in una diversa TRB. Le tracce vengono 

emulate variando la fase del clock che arriva alle TRB. 
• Al termine verifica l’output sui plot. Vedi  Figura 28 e Figura 29 per informazioni 

piu’ precise. 
• Il valore corretto atteso tipicamente e’ di 12 ns. 
• Se c’e’ necessita’ di cambiare il valore di default la procedura e’ la seguente: 

� Nel pannello di Start-Up premere il pulsante Show Cmd; 
� Si apre una finestra che va abilitata premendo la freccia nera rivolta a destra; 
� Premere il pulsante CPU Ck; 
� Nella nuova finestra inserire il valore desiderato nel campo ‘delay’; 

Attenzione: il valore va inserito in tick; ogni tick vale 150 ps; per cui se si 
vuole inserire un valore di fase di 16 ns bisogna scrivere 107; 

� Solo dopo aver scritto il numero, premere la freccia rivolta a dx; in questo 
modo il valore viene settato; 

� Se si vuole verificare si puo’ vedere il valore corrente andando nel pannello 
Start-Up, premendo il tasto Show Detail e leggerlo nel campo CPU CK delay. 

 
2.7.7. Test Serializers 

 
• Nel pannello  Minicrate Tests, sottopannello Miscellaneous  premere pulsante Test 

Serializers 
• Premere freccia dx.  
• Attendere che nel campo “message” sia scritto READY. 
• Premi il pulsante TEST. 
• Attendi il completamento di tutte le tracce. 
• Ogni plot corrisponde ad una traccia emulata in una diversa TRB. Le tracce vengono 

emulate variando la fase del clock sulla Server Board 
• Al termine verifica l’output sui plot. Vedi  Figura 30 e Figura 31  per informazioni 

piu’ precise. 
• Il valore corretto atteso tipicamente e’ di 0 ns. 
 

2.7.8. Test TRB emulator 
 
• Nel pannello  Minicrate Tests, sottopannello TRB premere pulsante Test TRB 

emulator. 
• Premere freccia dx.  
• Attendere che nel campo “message” sia scritto READY. 
• Seleziona il primo pannello (test table) e premi il pulsante “load test table from 

default file”. 
• Premi il pulsante TEST. 
• Attendi il completamento di tutte le tracce. 
• Al termine verifica che la spia rossa “error” sia spenta e che il numero di errori sia 0.   
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• Premere freccia sx e poi freccia in alto. 
 
2.7.9. Test Snap e Software Reset 

 
• Nel pannello  Minicrate Tests, sottopannello Miscellaneous premere pulsante Test 

Snap/Soft Reset 
• Premere freccia dx.  
• Attendi il completamento del test 
• Al termine verifica che le spie verdi (Test Snap Ok? e Test Soft Ok?) siano accese.   
• Premere freccia sx e poi freccia in alto. 
 

2.8. Spegnimento in preparazione del dressing. 
 
• Spegnere DAQ:  

� Sull’interfaccia grafica di pccmslab premi stop, poi reset; 
� Premi Session->Close; 
� Session->Exit; 
� Poi premi File->Logout; 
� File->Exit; 
� Sull’xterm dove si e’ eseguito il comando ‘daqstart’ premere Control + C e 

verificare che ritorni il prompt; 
� Verificare che il processo xdaq.exe stia ancora runnando, se si fermarlo col 

comando ‘kill’; 
 
 
• Spegnere programma di test (pulsante Close VI); spegnere alimentatore 5V del 

minicrate, spegnere alimentatore 3.3 V del minicrate. 
• Spegnere laser TTCex (spia rossa spenta) 
• Sconnettere collegamenti al minicrate (cavi ottico , rs-485 e cavo TTC) 
• Sconnettere lo schedino di test per gli RPC e i Led dell’allineamento. 
• Sconnettere i cavi di trigger e i cavi di read-out. 
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Figura 23: TDC status per MB1 

 

 
Figura 24: TDC status per MB3 
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Figura 25: Pattern Unit Calibration per un minicrate MB1 
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Figura 26: Pattern Unit calibration per MB2 

 
Figura 27: Pattern Unit calibration per un MB3 
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Figura 28: Esempio di output corretto per ili test CPU CK Phase (MB2): il primo grafico in alto 
mostra in quale time-slot della Pattern Unit (PU index) il dato e’ trovato correttamente in funzione 
della fase del clock alla CPU che induce lo start dell’emulazione dei BTI . Ciascun Plot nella legenda 
si riferisce ad una diversa TRB. Si noti: lo sfasamento di 7 time-slot tra le board PHI e quelle 
THETA; una regione di circa 4 ns in cui la time-slot non e’ stabile. Questa ultima osservazione indica 
che la fase del clock alla CPU non assicura che le tracce siano emulate dai dispositivi con un timing 
stabile e che siano quindi attese in uscita alla stessa time-slot.  Per ciascun punto vengono emulate 10 
tracce. Nel secondo grafico sono mostrati gli errori secondo il codice nella legenda a sinistra. Possono 
esserci errori tipicamente nella zona in cui il clock e’ critico. Si osservi come per un valore di 12 ns il 
clock e’ in una regione stabile. 

 
Figura 29: Esempio di corretto output per il Test CPU CK Phase (MB3) 
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Figura 30: Output del Test Serializers per un MB3. Si osservi come un valore della fase di clock 
uguale a 0 (il default) sia accettabile. L'interpretazione dei plot e' simile a quelli in Figura 28. Ogni 
plot si riferisce ad una diversa TRB, mentre la fase del clock e’ quella alla Server Board. 

 

 
Figura 31: Esempio di output del Test Serializers per un MB2: Si noti come la TRB5 (la THETA 1 
per un MB2) abbia sempre errori su tutto l’intervallo dello scan di fase. Questo indica un 
malfunzionamento della scheda o un difetto nella connessione di essa alla Server Board indipendente 
dalla sincronizzazione reciproca.  
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Cablaggio del Minicrate al Frontend 
 

2.9. Orientamento 
 
Inserire il MC nella testata dummy. Per l’orientamento, la definizione di “sopra” e 
“sotto” è la seguente: se si tengono le TRB θ (eccetto per MB4) sulla propria destra e le 
TRB φ sulla sinistra, PHI2 è sopra e PHI1 è sotto . Se il MC e’ di tipo L il cavo di 
alimentazione deve essere all’estremo sinistro, se e’ di tipo R deve essere all’estremo 
destro. 
 

2.10. Posizionamento 
 

Tabella 3: misure di riferimento per i 
minicrates rispetto al front-end 

 

Il foro centrale dell’asola all’estremo sinistro del 
MC va allineato col foro di riferimento secondo 
la colonna MC-phi1 della Tabella 3 . 
MC-phi1 e’ la distanza del foro dal bordo del 
superlayer PHI1: scegliere nella tabella la riga 
corrispondente al tipo di MC. 
Mettere le etichette identificative se non vi sono 
gia’. 
Bloccare il MC con una vite ai due estremi. 
 

2.11. Connessione dei cavi al MC  
 
Scegliere i cavi segnale, i cavi test pulse e le 
buste dei tipi indicati nelle liste DRESSING 
allegate a queste istruzioni. 
Per MB1, i cavi sono gia’ separati in scatole 
MB1PHI1 e MB1PHI2. 
 
Togliere i coperchi sulle TRB, allentando le viti. 
Non e’ necessario togliere i coperchi di SB e 
Link.  
 
Connettere i cavi segnale ai frontend. Inserire 
tutti i connettori dei cavi PHI sul MC. Sia PHI1 
che PHI2 hanno la parte di connettore da cui esce 
il cavo verso l’esterno del MC. 
Ogni cavo ha un numero, indica il corrispondente 
connettore sul minicrate in cui va inserito 
partendo a contare da sinistra. 
 Dopo aver connesso tutti i connettori PHI1 e 
PHI2 al MC, lasciare penzolare i cavi verso 
l’esterno.  
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Nota Bene: prima di inserire un connettore, controllare che i pin del connettore maschio 
non siano storti. 
 

2.12. Connessione del MC per il FULL TEST  
 
Connettere i cavi front-end ai connettori sulla testata dummy (il connettore in cui va 
inserito e’ scritto sul cavo; se non c’e’ di norma quello con il cavetto rosso va in quello 
A). 
Scrivere a pennarello sul cavo l’identificatore del connettore di arrivo al frontend e il 
Super-Layer. Es: PHI1 1A, PHI2 1A, etc.. 
 
 
Connettere cavi THETA FE . I FE secondo l’ordine nella Tabella 4: 
 

TRBtheta1 TRBtheta2 (rightmost) 
connettore 3 connettore 4 connettore 7 connettore 8 
connettore 1 connettore 2 connettore 5 connettore 6 
Tabella 4: connessione dei cavi front-end Theta 

 
2.13. Connessione cavi test pulse alla CCB e alla testata 

 
Connettere i cavi test-pulse per i SL PHI e per quello theta. Sono a coppie con etichette 
bianche e rosse (tipo B e tipo A rispettivamente). 
 
Rossi nel blocco a sinistra, Bianchi nel blocco a destra nella CCB. Sulla testata, in ogni 
coppia, rosso a sinistra e bianco a destra. La testata THETA e’ capovolta. 
 
I cavi Theta sono gia’ connessi al front-end e rimarranno sempre sulla testata dummy; 
quelli PHI vanno connessi alla testata dummy e poi saranno spediti con il minicrate. 
I cavi hanno una sigla Sx-yT :  

x e’ il superlayer: 1 = PHI1 ; 3 = PHI2 
y e’ un numero progressivo che indica in quale connettore del SL va connesso 
partendo a contare da sinistra ; 
T e’ il tipo: A o B  
 

In Figura 32 si vede che sul SL ogni connessione di test-pulse e’ composta da una coppia 
di tipo A e B. 
Ad esempio, sul superlayer PHI2, nella terza coppia di connettori a partire da sx andranno 
inseriti i cavi S3-3A e S3-3B. 
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S3-1  S3-2   S3-3   S3-4    S3-5   S3-6  S2-3   S2-4 
 
 
S1-1  S1-2   S1-3   S1-4    S1-5   S1-6   S2-1  S2-2 

S3-1 S3-2   S3-3   S3-4   S3-5   S3-6   S2-3    S2-4 
 
 
S1-1  S1-2   S1-3   S1-4    S1-5   S1-6   S2-1  S2-2 

RED WHITE 

cavi A 

cavi B 

 
Figura 32: connessione dei cavi test-pulse 

 
Il numero e la lunghezza dei cavi sono descritti per ciascun tipo di Minicrate nei fogli di 
dressing in appendice. 
 
Per MB1, per il test serve una coppia di cavi TP in piu’, che devono essere tolti alla fine 
del test. Questo e’ specifico della testata dummy in uso e non avviene per il minicrate 
connesso alla camera. 
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3. Istruzioni per il Test Post-Dressing  
 

3.1. Preparazione preliminare 
 
• E’ possibile richiudere i coperchi (anche senza stringerli), diminuisce la probabilita’ 

di rumore elettronico ma peggiora la dissipazione del calore e aumenta i tempi di 
eventuali interventi. Quando si chiude il coperchio sulla SB bisogna ricordarsi di 
avvitare la forcella del cavo I2C degli slow control (che e’ connessa a massa; vedi 
paragrafo 1.16) sotto la vite di fissaggio del coperchio piu’ vicina.  

 
• Connetere Splitter Board alla Testata (i due cavi blu di alimentazione sono 

interscambiabili). 
• Connettere cavo soglie  e cavo slow-control (rosa dalla CCB) piu’ corto alla Splitter 

(vi sono due connettori per questo e sono identici; il rimanente e’ per il cavo slow 
control che arriva dal superlayer Theta). 

• Connettere Alimentazione del superlayer Theta alla Splitter. 
• Connettere la Splitter Board a massa avvitando il cavo marrone alla testata (la vite e’ 

quella dorata vicino ai connettori 6B e 7A di PHI1) 
• Connettere i cavi di trigger (labellati left e right) che vanno al Sector Collector; 
•  Connettere i cavi read-out (labellati up e down) che vanno alla ROS. 
• Connettere cavi slow-control PHI1 e PHI2 (rosa dalla CCB). 
• Connettere fibra TTC, fibra RS232 Ottica, e RS485 (vedi Figura 21). 
 

3.2. Pre-accensione 
 
• Abilitare lo switch ON del laser sul module TTCex (spia rossa accesa). 
• Accendere alimentatori del front-end. 
• Accendere alimentatore minicrate per la 3.3 V 
• Verificare che siano accesi i moduli per le connessioni ottiche (a fianco degli 

alimentatori per il front-end) e RS485 (a fianco del video di pccmslab)  con il 
minicrate e che non vi sia acceso il led rosso del modulo RS485 (se e’ acceso, 
premere il pulsantino di reset di color rosso posto vicino al led) 

 
3.3. Test – procedura sequenziale  

 
• Accendere la Daq (vedi paragrafo 2.2) 
• Lanciare il programma ‘mc_test’ sul pc windows utilizzando lo shortcut sul desktop. 
• Lanciare il programma utilizzando la freccia bianca in alto a sx nella finestra. 
• Digitare nella nuova finestra il tipo di minicrate (es: mb1 , mb2, ...) e l’ID del 

minicrate (e’ nel file assembly-DB, sono le ultime 5 cifre del numero che lo identifica 
e che e’ riportato sull’etichetta). 

• Sulla finestra principale, nel pannello di start-up premere il pulsante START MC. 
• Rispondere OK. 
• Finestra check_daq: premere ; attendere il messaggio ‘Check Done’ ;  

in caso di errore verificare la connessione con la daq (....) e/o disabilitare il firewall. 
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• Se tutto e’ ok ,premere OK e poi premere la freccia in alto (secondo tasto in alto a 

sinistra) . 
•  Comparira’ una finestra con scritto: Trying to connect to CCB. 
• Accendere l’alimentatore per la 5 V e poi premere OK. 
• Veficare che compaia scritta “CCB stopped on boot program” e premere OK 
• Il programma compie in automatico un check delle comunicazione con il minicrate 

(porta primaria ottica e secondaria rs-485) premere OK entrambe le volte. 
• Si aprira’ la finestra di status_boot_display, premere e attendere messaggio 

‘Ok. Boot data were found.’ e poi verificare lo stato del boot (spia Boot Status verde, 
nessuna spia rossa in tutti i pannelli) 

 
• Premere 
• SI apre finestra con scritto ‘Starting minicrate program, etc...’, premere OK e 

attendere. 
• Si apre una finestra con messaggio ‘Select...’, premere OK. 
• Premere pulsante START TEST e attendere che compaia il pop-up ‘Test Finished. 

Etc….’, premere OK. 
• Non ci devono essere spie rosse accese tranne quelle nel pannello TRB test nel 

quadrante PI test. 
Essi corrispondono ai connettori della Server Board in cui non sono collegate TRB 
(dipende dal layout del minicrate). Se a sinistra della riga di led rossi ce n’e’ uno 
verde vuol dire che tutto va bene. 

• Premere pulsante CLOSE VI 
• Al pop-up ‘Starting FEB test’, premere OK e attendere il pop-up ‘Test Done’ e 

premere OK. 
• I led devono essere verdi: uno in corrispondenza di ogni front-end board nella testata; 

La linea con Bus0 ri riferisce al SL PHI1, Bus1->PHI2, Bus2->Theta. 
Su PHI1 e PHI2 ci sono 18 front-end board, su THETA 13 + 1 particolare (e’ l’ultima 
e deve avere il led blu) 

• Premere pulsante CLOSE. 
 

3.4. Configurazione Dispositivi 
 
• Pannello di Start-Up, premere pulsate Configure MC, premere OK al pop-up.   
• Nella finestra config_minicrate premere il led (che e’ spento) select ALL;  
• Premere pulsante CONFIGURE. 
• Selezionare il file di configurazione (in D:\test mc\config_files): 
 
Minicrate Type Folder File 
MB1 mb1 Cfg1_c_mb1.cfg 
MB2 mb2 Cfg1_c_mb2.cfg 
MB3 mb3 Cfg1_c_mb3.cfg 
MB4 (9-11)   
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• Premere OK e attendere fino al pop-up ‘Configuration Done’; nel frattempo verificare 
che non si accendano spie rosse. 

• Premere OK al pop-up Configuration Done. 
 

3.5. Impostazione del timing sulle TRB 
 
• Lanciare Monitor 7  
• Connections -> MC settings; CCB Port deve essere su TCP/IP Port. 
• Remote Host deve essere pccmslab.bo.infn.it 
• CCB Identifier deve essere 0x0. 
Spedire al Minicrate il comando TTC_FineDelay con il primo parametro (char ch) uguale 
a  0 e il secondo uguale a 4.0 
 
 
• Ora l’utente ha la scelta di quali test fare e quando farli partire. Tra un test e il 

successivo, verificare nel pannello Start-Up, premendo il tasto Show Detail lo stato 
del minicrate. 
Non ci devono essere led rossi accesi. 
Nel campo BoardMaxTemp si puo’ vedere la temperatura massima raggiunta 
dal minicrate. Verificare che essa non superi i 48 gradi. Nel caso spegnere il 
minicrate, attendere una decina di minuti e ripetere le procedura sequenziale di 
test. 
 
3.6. Elenco Test da Effettuare 

 
Importante: in molti test compare un pulsante con scritto ‘jpeg’. Esso puo’ essere 
utilizzato per salvare un’immagine del programma di test alla fine di ogni singolo test. 
E’ vivamente consigliato utilizzarlo alla fine di ogni test per fare un’immagine di ogni 
schermata della finestra.  
Puo’ essere ripetuto piu’ volte, il pulsante crea una nuova immagine e non sovrascrive la 
precedente. 
Le immagini sono salvate in D:\mc_test\TEST_DATA; si trovano tutti i folder (sono del 
tipo mbx_nn, con x tipo del minicrate e nn il numero seriale) con le immagini ed i 
logfiles. 
 

3.6.1. Test corretta cablatura dei cavi segnale 
 
• Nel pannello  Minicrate Tests, sottopannello TP/TDC premere pulsante Test TP 

cable. 
• Premere freccia dx e attendere stato Finished. 
• Verificare che le luci verdi in RESULTS siano accese, una per front-end board 

connessa a ciascun superlayer; verificare che in test main siano accese su ciascun 
superlayer la prima colonna di celle ogni 4, una colonna per ciascuna front-end board 
(esempio in Figura 33). Deve essere accesa la luce verde di Test OK. 

• Premere freccia sx e poi freccia in alto. 
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3.6.2. Test crosstalk 
 
• Nel pannello  Minicrate Tests, sottopannello TP/TDC premere pulsante Test 

Crosstalk. 
• Premere freccia dx e attendere stato Finished. 
• Verificare che i due led verdi di Test OK siano accesi. 
•  Verificare nel pannello Occupancy (per tutti e tre i SL) che nei canali OFF non ci 

devono essere hits e in quelli ON non ci devono essere canali senza hits.  
• Premere freccia sx e poi freccia in alto. 
 

3.6.3. Test TRB TP 
 
• Nel pannello  Minicrate Tests, sottopannello TRB premere pulsante Test TRB TP. 
• Premere freccia dx.  
• Attendere che nel campo “message” sia scritto READY. 
• Seleziona il primo pannello (test table) e premi il pulsante “load test table from 

default file”. 
• Premi il pulsante TEST. 
• Attendi il completamento di tutte le tracce. 
• Al termine verifica che la spia rossa “error” sia spenta e che il numero di errori sia 0.   
• Premere freccia sx e poi freccia in alto. 
 

3.6.4. Test Bti Skew 
 
• Nel pannello  Minicrate Tests, sottopannello TRB premere pulsante Test Bti Skew. 
• Premere freccia dx.  
• Attendere che nel campo “message” sia scritto READY. 
• Premi il pulsante Start TEST. 
• Attendi il completamento di tutte le tracce (il test ha una durata di circa 2 ore). 
• Al termine verifica l’output come da Figura 34 e Figura 35. Si deve accendere la luce 

verde di Test OK.   
• Premere freccia sx e poi freccia in alto. 
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Figura 33: Esempio di Output per il Test TP Cable per un MB3 

 

 
Figura 34: Output del test di Bti Skew: ogni curva si riferisce agli errori (su 100 pattern per punto) 
eseguendo un test pulse variando la fase del segnale impulsato su un BTI. Come si vede dai primi due 
grafici dall’alto ci deve essere una regione in cui il numero di errori e’ inferiore a 10 (tra 120 e 180) e 
le due zone in cui iniziano gli errori devono essere sovrapposte per tutti i BTI con uno sfasamento di 
3-4 ns (ricorda : 1 tick nell’asse x = 150 ps). L’ultimo grafico permette di visualizzare la curva 
singolarmente per ciascun BTI. 
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Figura 35: Output del Test di BTI skew: I due grafici mostrano in ascissa il BTI impulsato col test 
pulse e in ordinata il valore di delay sulla fase del test pulsein cui gli errori vanno a 0 (global falling 
plot) e quello in cui aumentano (global rising plot). Lo sfasamento in ordinata di tutti i punti deve 
essere compreso in un intervallo tipico di 3-4 ns. 
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4. Preparazione per la spedizione 
 

4.1. Disconnessione dei cavi del MC dopo il FULL TEST 
 
• Spegnere programma di test (pulsante STOP VI) ; 
• Spegnere Monitor 7; 
• Spegnere alimentatore 5V del minicrate; 
• Spegnere alimentatore 3.3 V del minicrate; 
• Spegnere alimentatori front-end. 
• Scollegare spina alimentatori front-end. 
• Spegnere laser TTCex (spia rossa spenta) 
• Spegnere i crates VME. 
• Sconnettere collegamenti al minicrate (cavi ottico,RS485 e seriale) 
• Staccare i cavi soglie e quello dello slow-control connesso alla Splitter dal lato della 

Splitter stessa. 
• Staccare i cavi slow control PHI1 e PHI2 dal lato della testata. 
• Staccare la connessione della Splitter a PHI1 e a PHI2 e spostarla dove non intralci! 
• Sconnettere i cavi test pulse: 

� Quelli theta vanno sconnessi sulla CCB utilizzando pinzette con punta lunga e 
prestando la massima attenzione. 

� Quelli S1-4 e S3-4 per i minicrate di tipo MB1 vanno sconnessi sul lato CCB. 
� I phi rimanenti vanno sconnessi sul lato del front-end e poi verranno spediti 

col minicrate: farne un bandolo unico ripiegandolo vicino al MC nello spazio 
libero al di sopra del MC all’interno della testata. 

 
4.2. Impacchettamento dei cavi nelle buste di alluminio 

 
• Preparare i coperchi per chiudere il MC se non gia’ fatto: mettere in posizione tutte le 

piastre, comprese quelle THETA (anche se non le si cabla). Quando si chiude il 
coperchio sulla SB bisogna ricordarsi di avvitare la forcella del cavo I2C degli slow 
control (che e’ connessa a massa; vedi paragrafo 1.16) sotto la vite di fissaggio del 
coperchio piu’ vicina.  

 
• Mettere la protezione con  lingua d’alluminio sul buco dove passano i cavi dello Slow 

Control (rosa) nella piastra centrale se non gia’ fatto. 
 
• Chiudere i coperchi e assicurarsi che siano avvitati bene. 
 
I cavi vanno inseriti nelle buste di alluminio, che sono di diversa lunghezza. L’elenco dei 
cavi che devono andare in ogni specifica busta è nelle indicazioni di DRESSING  in 
appendice. 
Ci sono da 6 a 10 buste di lunghezza diversa da riempire per ogni minicrate a seconda del 
tipo. 
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Le buste vanno poste sopra il minicrate eccetto che per i minicrate di tipo MB4 che 
devono bensi` essere inserite negli interstizi fra il minicrate stesso e i 2 superlayer PHI1 e 
PHI2. Diventano cosi` accessibili i coperchi dei minicrate ed i connettori RJ di readout, 
cosa che dovrebbe facilitare sia l’installazione che la manutenzione. 
 
Posizione e direzione dei recuperi dei cavi nelle buste sono specificati nelle indicazioni di 
DRESSING. 
Controllare sul riferimento anche la posizione del filo rosso sul cavo, che deve sempre 
essere a sinistra. 
Attenzione a non far toccare fra di loro i cavi all’interno della stessa busta. I cavi devono 
essere mantenuti separati fra di loro con il nastro adesivo d’alluminio, se necessario. 
 
Mettere tutte le buste di PHI1, seguendo l’ordine della tabella nelle indicazioni di 
DRESSING allegate in fondo a queste istruzioni. Poi mettere tutte le buste di PHI2. 
Tenere la parte aperta delle buste nella direzione dei connettori. 
 
Posizionamento iniziale della prima busta: per i minicrate MB1,MB2,MB3 la prima 
busta va posizionata in maniera tale che il suo estremo a destra sia appena oltre il 
coperchio dell’ultima TRB Theta, in modo pero’ da non coprire i connettori dei cavi di 
read-out. 
 
Chiudere la busta e immobilizzare il cavo, soprattutto in prossimità dei connettori, con il 
nastro adesivo di alluminio. La busta va chiusa bene usando pezzi di nastro adesivo in 
alluminio, per evitare che i cavi escano quando il MC e’ in posizione verticale all’interno 
della camera. 
 
Alla fine, stringere le buste tra di loro e al MC con degli anelli belli stretti di nastro 
adesivo d’alluminio. 
 

• Le buste in Al PET contenenti i cavi segnale devono essere raggruppate in modo 
che quelle relative allo stesso superlayer siano adiacenti  (esempio su MB1 
bisogna completare ed inserire nelle clips prima le 5 buste di PHI1 e poi le 5 di 
PHI2) invece di essere disposte alternate (una di PHI1, poi una di PHI2 etc) : e` 
cosi` piu` semplice spostare in blocco i cavi di ciascun superlayer per aprire un 
coperchio del minicrate anche in fase di installazione. 

• Chiudere le buste che contengono i cavi con maggiore frequenza (piu` pezzetti di 
nastro di alluminio) perche` quando le camere sono installate in CMS i cavi 
tendono ad uscire dalle buste stesse. 

 
Attenzione: le buste per i cavi PHI1 e quelle per i cavi PHI2 vanno strette da anelli di 
alluminio separati, cosi’ da poterle spostare in maniera indipendente. 
 
NOTA per le BUSTE in MB1 e MB2: 

Ricordarsi di controllare sul riferimento la posizione dei connettori sul lato PHI1 e 
PHI2 separatamente, dal momento che non sono esattamente simmetrici. I 
minicrates sono infatti di tipo S+ e S- (cioe’ shift di Phi2 rispetto a Phi1 negativo 
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(verso sinistra, verso l’esterno) o positivo (verso destra, verso l’interno)) (vedi 
tabella nella prima pagina di queste istruzioni). 

 
Importante: Non tirare i cavi front-end perche’ si potrebbe leggermente discostare il 
connettore dalla ROB. 
 

4.3. Preparazione conclusiva 
 
• Aggiungere coperchio al connettore TTC. 

• Scrivere con un pennarello il numero intero di identificatore della CCB (vedi file 
assemblyDB) sul coperchio TTC e il numero del minicrate subito sotto il 
coperchio. 

• Aggiungere la staffa con l’adattatore per il cavo VETO. 
 

4.4. Nota sulla preparazione delle staffette e dei fermacavi 
 
Il numero e il tipo dei fermacavi e’ indicato dai fogli di dressing per ciascun tipo di 
minicrate. 
Ce ne sono di due tipi, uno spesso 15 mm  e l’atro 20 mm. 
Ogni fermacavo va inserito su una staffetta d’alluminio. 
La staffetta dovra’ essere posizionata sul minicrate con la parte ricurva verso il superlayer 
PHI1 e rivolta verso l’alto.  
Vi sono 3 possibili posizioni per inserire il fermacavo (vedi Figura 36) . 
Di solito (per MB1,2,3) i fermacavi vanno in posizione 2. Solo per la staffa piu’ vicina 
subito a destra della link board vanno in posizione 1. Se vi sono altre staffe da mettere a 
sinistra di questa anch’esse vanno in posizione 1. 
La posizione dove mettere le staffe con i fermacavi sono indicate dai fogli di dressing. 
Tipicamente possono essere imprecise fino a 5-6 cm, quindi non bisogna porsi eccessivi 
scrupoli per cercare un posizionamento esatto. 
 
Importante: non mettere le staffe dove ci sara’ la splitter board: circa sulla prima TRB 
subito a destra della Server Board. 
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Figura 36: Posizioni per inserire i fermacavi sulle staffette di alluminio. Il fermacavo va messo con 
l’apertura rivolta verso il superlayer PHI 2. 
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MB1 DRESSING 
 

CAVI LV Splitter > SL phi1/2 fissati su cornice phi2 sotto connettore LV del SL  
Lunghezza LV phi1 89cm 
Lunghezza LV phi2 67cm 
Lunghezza LV theta 214cm 
 
CAVI TEST PULSE lunghezza 3400mm: 6 coppie 
          Labels : S1-1,2,3 (per PHI1) ; S3-1,2,3  (per PHI2) 
CAVI SEGNALE PHI1/2 lunghezza 5 step : 
 6 tipo 1A (PHI1) ; 6 tipo 1B (PHI2); 1 tipo 2A (PHI1) ; 1 tipo 2B (per PHI2) 
 
10 BUSTE IN PET + Al  ( 4 x 170cm + 2 x 80cm + 4 x 91cm)  
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
170 

PHI1_1 
 

PHI1_6 

Poco 
 

Poco  

 

 
170 

PHI1_2 
 

PHI1_7 

Poco 
 

Poco 

 

 
80 

 
PHI1_3 

 

 
MC sx 

 

 

 
91 

 
PHI1_4 

 

 
SL dx 

 

 
91 

 
PHI1_5 

 

 
MC sx 

 

Analogamente per PHI2 
Raggruppare buste e cavi PHI1 separatamente da buste e cavi PHI2 (non intercalarle)  

1 da 15mm in corrispondenza ultimo coperchio TRB theta 
5 staffette; 

FISSACAVO PIATTI: 
1 da 15mm a sinistra MC fissaggio basso 
2 da 20mm a sinistra splitter 
1 da 20mm a destra splitter 

IN CASO MANIFOLD A SX ATTACCARCI 1a STAFFETTA   
 
CAVI DCS (da connettore a connettore) 
1 theta 115cm 
1 phi1 125cm 
1 phi2 135cm 
1 cavo CCB > splitter lunghezza 50cm 
CAVO SOGLIE CCB >> SPLITTER 40cm 

 55



MB2 DRESSING 
 

CAVI LV Splitter > SL phi1/2 fissati su cornice phi2 sotto connettore LV  
Lunghezza LV phi1 95cm 
Lunghezza LV phi2 80cm 
Lunghezza LV theta 220cm 
 
CAVI TEST PULSE lunghezza 3500mm: 8 coppie 
          Labels : S1-1,2,3,4 (per PHI1) ; S3-1,2,3,4 (per PHI2) 
CAVI SEGNALE PHI1/2 lunghezza 4 step : 
 7 tipo 1A (PHI1) ; 7 tipo 1B (PHI2); 1 tipo 2A (PHI1) ; 1 tipo 2B (per PHI2) 
 
6 BUSTE IN PET + Al  ( 4 x 200cm + 2 x 160cm) 
 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
200 

PHI1_1 
PHI1_3 
PHI1_7 

MC dx 
MC dx 
Poco sx 

 

 
200 

PHI1_2 
PHI1_5 
PHI1_8 

SL sx 
MC sx 
Poco sx 

 

 
160 

PHI1_4 
 

PHI1_6 

MC sx 
 

Poco SL dx 

 

Analogamente per PHI2 
Raggruppare buste e cavi PHI1 separatamente da buste e cavi PHI2 (non intercalarle)  

1 da 15mm in corrispondenza a ultimo coperchio TRB theta 
6 staffette; 

FISSACAVO PIATTI: 
2 da 15mm contigui a sinistra MC  
1 da 20mm fra 1° e 2° TRB 
1 da 20mm fra 5° e 6° connettore segnali MC 
1 da 15mm con staffetta accorciata su supporto manifold o normale su cornice 

IN CASO MANIFOLD A SX ATTACCARCI 1a STAFFETTA  
 
CAVI DCS (da connettore a connettore) 
1 theta 115 cm 
1 phi1 150cm per MB2+; 145cm per MB2- 
1 phi2 155cm 
1 cavo CCB > splitter lunghezza 50cm 
 
CAVO SOGLIE CCB >> SPLITTER 40cm 
 
 

 

 56



MB3 DRESSING 
 

CAVI LV Splitter > SL phi1/2 fissati su cornice phi2 sotto connettore LV  
Lunghezza LV phi1 120cm 
Lunghezza LV phi2 105cm 
Lunghezza LV theta 220cm 
 
CAVI TEST PULSE lunghezza 3500mm: 10 coppie 
    Labels : S1-1,2,3,4,5 (per PHI1) ; S3-1,2,3,4,5 (per PHI2) 
CAVI SEGNALE PHI1/2 lunghezza 5 step : 

 9 tipo 1A (PHI1) ; 9 tipo 1B (PHI2);   
 
8 BUSTE IN PET + Al  ( 4 x 268cm + 2 x 200cm + 2 x 110cm) 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
268 

PHI1_1 
PHI1_4 
PHI1_8 

MC dx 
MC dx 
SL dx  

 

 
268 

PHI1_2 
PHI1_6 
PHI1_9 

MC sx 
MC sx 
MC sx 

 

 
200 

PHI1_3 
 

PHI1_7 

SL sx 
 

MC sx 

 

 
110 

 
PHI1_5 

 

 
MC sx 

 

 
 
 

Analogamente per PHI2 
Raggruppare buste e cavi PHI1 separatamente da buste e cavi PHI2 (non intercalarle)  

1 da 15mm in corrispondenza a ultimo coperchio TRB theta 
8 staffette 

FISSACAVO PIATTI: 
1 da 15mm a sinistra MC  
5 da 20mm distribuiti lungo MC 
1 da 15mm con staffetta accorciata su supporto manifold o normale su cornice 

 
CAVI DCS (da connettore a connettore) 
1 theta 115 cm 
1 phi1 205cm 
1 phi2 210cm 
1 cavo CCB > splitter lunghezza 50cm 
 
CAVO SOGLIE CCB >> SPLITTER 40cm 
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MB4/10 DRESSING 
 

Cavi LV Splitter > SL phi1/2 fissati su cornice PHI2 
 
Lunghezza LV phi1 67cm 
Lunghezza LV phi2 67cm 
 
CAVI TEST PULSE lunghezza 180cm :8 coppie 
          Labels : S1-1,2,3,4 (per PHI1) ; S3-1,2,3,4 (per PHI2) 
 
CAVI SEGNALE PHI1/2 lunghezza 4 step: 7 tipo 1A (PHI1) ; 7 tipo 1B (PHI2); 1 tipo 2A 
(PHI1) ; 1 tipo 2B (per PHI2) 
 
6 BUSTE IN PET + Al  ( 4 x 200cm + 2 x 160cm) 
 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
200 

PHI1_1 
PHI1_3 
PHI1_7 

MC dx 
MC dx 
Poco  

 

 
200 

PHI1_2 
PHI1_5 
PHI1_8 

SL sx 
MC sx 
Poco 

 

 
160 

PHI1_4 
 

PHI1_6 

MC sx 
 

Poco SL dx 

 

 
Analogamente per PHI2  
 
Le buste relative a PHI1 inserite “sotto” il minicrate 
Le buste relative a PHI2 inserite “sopra” il minicrate 
 
Staffette e clips di fissaggio ancora da definire  
 
Cavi DCS 
Phi1 lunghezza 140cm 
Phi2 lunghezza 140cm 
 
CAVO SOGLIE CCB > SPLITTER lunghezza 40 cm 
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MB4/4 DRESSING 
 

Cavi LV Splitter > SL phi1/2 fissati solo su barretta fissata al supporto splitter 
 
Lunghezza LV phi1 67cm 
Lunghezza LV phi2 67cm 
 
CAVI TEST PULSE lunghezza 180cm: 10 coppie 
    Labels : S1-1,2,3,4,5 (per PHI1) ; S3-1,2,3,4,5 (per PHI2) 
 
CAVI SEGNALE PHI1/2 lunghezza 5 step: 
 9 tipo 1A (PHI1) ; 9 tipo 1B (PHI2);   
 
8 BUSTE IN PET + Al  ( 4 x 268cm + 2 x 200cm + 2 x 110cm) 
 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
268 

PHI1_1 
PHI1_4 
PHI1_8 

MC dx 
MC dx 
SL dx  

 

 
268 

PHI1_2 
PHI1_6 
PHI1_9 

MC sx 
MC sx 
MC sx 

 

 
200 

PHI1_3 
 

PHI1_7 

SL sx 
 

MC sx 

 

 
110 

 
PHI1_5 

 

 
MC sx 

 

 
 
 

 
Analogamente per PHI2  
 
Le buste relative a PHI1 inserite “sotto” il minicrate 
Le buste relative a PHI2 inserite “sopra” il minicrate 
 
Staffette e clips di fissaggio ancora da definire  
 
Cavi DCS 
Phi1 lunghezza 160cm 
Phi2 lunghezza 160cm 
 
CAVO SOGLIE CCB > SPLITTER lunghezza 40 cm 
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MB4/8,12 DRESSING 
 

Cavi LV Splitter > SL phi1/2 fissati su cornice PHI2 
 
Lunghezza LV phi1 90cm 
Lunghezza LV phi2 80cm 
 
CAVI TEST PULSE lunghezza 240cm 
 
CAVI SEGNALE PHI1/2 lunghezza 6 step (11 cavi tipo 1 e 1 cavo tipo 2 per SL) 
 
 
8 BUSTE IN PET + Al  ( 8 x 355cm) 
 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
355 

PHI1_1 
PHI1_5 
PHI1_9 

MC dx 
MC dx 
SL dx  

 

 
355 

PHI1_2 
PHI1_6 

PHI1_10 

SL  sx 
MC dx 
SL dx 

 

 
355 

PHI1_3 
PHI1_7 

PHI1_11 

SL sx 
MC sx 
SL dx 

 

 
355 

PHI1_4 
PHI1_8 

PHI1_12 

SL sx 
MC sx 
MC sx 

 

 
 
 

 
Analogamente per PHI2  
 
Le buste relative a PHI1 inserite “sotto” il minicrate 
Le buste relative a PHI2 inserite “sopra” il minicrate 
 
Staffette e clips di fissaggio ancora da definire  
 
Cavi DCS 
Phi1 lunghezza 215cm 
Phi2 lunghezza 215cm 
 
CAVO SOGLIE CCB > SPLITTER lunghezza 50 cm 
 
Supporti splitter board fissati a 190 e 194 cm di distanza dal bordo honeycomb 
 (distanza misurata dal bordo sx supporti a bordo sx profilo honeycomb frontale) 
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MB4/9-11 DRESSING 
 

Cavi LV Splitter > SL phi1/2 fissati su cornice PHI2 
 
Lunghezza LV phi1 cm 90cm 
Lunghezza LV phi2 cm 67cm 
 
CAVI TEST PULSE lunghezza 180cm : 6 coppie 
          Labels : S1-1,2,3 (per PHI1) ; S3-1,2,3  (per PHI2) 
CAVI SEGNALE PHI1/2 lunghezza 4 step: 6 tipo 1A (PHI1) ; 6 tipo 1B (PHI2) 
 
8 BUSTE IN PET + Al  ( 4 x 170cm + 2 x 80cm + 2 x 91cm) 
 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
170 

PHI1_1 
 

PHI1_5 

Poco 
 

Poco  

 

 
170 

   PHI1_2 
 

PHI1_6 
 

      Poco 
 

Poco 

 

 
80 

 
PHI1_3 

 

 
MC sx 

 

 

 
91 

 
PHI1_4 

 

 
SL dx 

 

 
Analogamente per PHI2  
 
Le buste relative a PHI1 inserite “sotto” il minicrate 
Le buste relative a PHI2 inserite “sopra” il minicrate 
 
Staffette e clips di fissaggio ancora da definire  
 
Cavi DCS 
Phi1 lunghezza 110cm 
Phi2 lunghezza 110cm 
 
CAVO SOGLIE CCB > SPLITTER lunghezza 40 cm 
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MB4 DRESSING 
 

Cavi LV Splitter > SL phi1/2 fissati su cornice PHI2 
 
Lunghezza LV phi1 80cm 
Lunghezza LV phi2 67cm 
 
CAVI TEST PULSE lunghezza 240cm 
 
CAVI SEGNALE PHI1/2 lunghezza 6 step (12 cavi tipo 1 per SL) 
 
8 BUSTE IN PET + Al  ( 8 x 370cm) 
 
Lunghezza 
Busta (cm) 

Cavi 
inseriti 

Recupero 
Cavo 

 

 
370 

PHI1_1 
PHI1_5 
PHI1_9 

MC dx 
MC dx 
SL dx  

 

 
370 

PHI1_2 
PHI1_6 

PHI1_10 

SL  sx 
MC dx 
SL dx 

 

 
370 

PHI1_3 
PHI1_7 

PHI1_11 

SL sx 
MC sx 
SL dx 

 

 
370 

PHI1_4 
PHI1_8 

PHI1_12 

SL sx 
MC sx 
MC sx 

 

 
 
 

 
Analogamente per PHI2  
 
Le buste relative a PHI1 inserite “sotto” il minicrate 
Le buste relative a PHI2 inserite “sopra” il minicrate 
 
Staffette e clips di fissaggio ancora da definire  
 
Cavi DCS 
Phi1 lunghezza 225cm 
Phi2 lunghezza 225cm 
 
CAVO SOGLIE CCB > SPLITTER lunghezza 50 cm 
 
Supporti splitter board fissati a 199 e 203 cm di distanza dal bordo honeycomb 
 (distanza misurata dal bordo sx supporti a bordo sx profilo honeycomb frontale) 
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Figura 37: posizione dei diversi fori sulla testata dummy (from M.Pegoraro) 
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5. Appendice: REVISIONE DELLE ISTRUZIONI PER 
L’ASSEMBLAGGIO DEI CAVI SEGNALE SUI MINICRATE  

 
 

Per le camere MB2: 
• Il layout dei cavi segnale sui minicrate per le camere MB2 va modificato per 

permettere l’accesso ai connettori RJ di readout nel caso in cui questi 
connettori siano situati sulla schedina terminale di sinistra (30 camere su 60): 
bisogna ripiegare le buste di Al PET  fino quasi a formare un cavo rotondo 
(senza esagerare ovviamente) in modo da poterle fissare sui fori disposti verso 
le due estremita` delle staffette di fissaggio. Questa procedura dovrebbe 
riguardare solo la parte “iniziale” delle buste da 200cm che contengono i cavi 
1 e 2 di ciascun superlayer: nel caso si possono inserire altri pezzi di buste di 
Al-PET con l’apertura (della V che costituisce la busta) disposta dal lato 
opposto in modo da mantenere integralmente la schermatura dei cavi stessi.  

 
Per le camere MB4: 

• La disposizione dei cavi segnale cambia completamente per tutti i tipi di 
MB4: 

le buste in Al-PET con i cavi non sono piu` disposte “sopra “ i coperchi del 
minicrate, oltre a permettere altre opzioni. Allego una foto per chiarire la nuova 
sistemazione per un superlayer. 
Le staffette di fissaggio per questo layout sono diverse ed attualmente in corso di 
preparazione; la procedura di preparazione delle buste e dei cavi rimane invece la 
stessa in quanto e` possibile preparare il tutto nella sequenza utilizzata finora 
(anche utilizzando le vecchie staffette volendo) e poi inserire le buste con i cavi e 
con le nuove staffette nell’interstizio.  
E` necessario cambiare il metodo di imballo per il trasporto dei  minicrate 
assemblati: i cavi devono essere ripiegati sul fianco dei minicrate invece che sopra 
i coperchi; inoltre le buste dei cavi devono essere tenute strette sui fianchi dei 
minicrate per facilitare l’inserzione dell’insieme nelle camere. 
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